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LIVE MEETING INTRODUCTION 
Global Crossing Live Meeting powered by Microsoft® is an integrated, interactive, and easy to 
use online meeting solution for small collaborative meetings and large events and training. Built 
with a familiar Microsoft® Office look and feel, Live Meeting is fully integrated with Ready-
Access® audio conferencing service giving users the ability to sign on to Live Meeting with one 
access number. In addition, customers with Ready-Access accounts are automatically 
provisioned to use Live Meeting. Microsoft Office Live Meeting allows you to  

�  Collaborate on documents in real time.  

�  Illustrate an idea for other team members using an electronic whiteboard.  
�  Receive instant feedback on a presentation.  

�  Visit Web locations and show your visit to all attendees.  
�  Share control of an application running on one user’s desktop 

�  Use surveys or other forms to gather information about meeting attendees 

�  Chat with participants who express interest in your products or services 
�  Demonstrate an application and allow learners to take control and practice using it 

Live Meeting introduces innovative new functionality and is designed to maximize productivity by 
integrating the convenience of a conference call with the benefits of an in-person meeting. It 
makes online meetings more successful and enhances real-time collaboration.  And, because it is 
a hosted Web service, Live Meeting requires no server software installation, and it makes use of 
your existing network and firewall configurations. Live Meeting installs a “thin client” during each 
user’s first use of Live Meeting, or a network administrator can install the client software “silently” 
for them.  

GETTING STARTED: 
ACCESSING LIVE MEETING 
Live Meeting is fully integrated with the Ready-Access® audio conferencing service.  You can 
login to Live Meeting using your Ready-Access numbers and you can control your audio 
conference using the Ready-Access controls that are integrated in Live Meeting.  This section 
steps you through setting up your integrated audio controls.  
 
 
 

1. Go to www.globalcrossing.com/conferencing  

2. Go to Live Meeting in Quick Links 

3. Select Start/Manage  

 

Enter your Ready-Access® phone number 

4. Enter your Access code 

5. Enter your chairperson pass code 

6. Click on log in 

 

 

 



 
 

7. You will land on an interim page and will be able to take 
three actions 

�  Access Live Meeting Home Page 

�  Download Live Meeting Outlook Add In 

�  Get Your Outlook Add-In Information 

8. Click on “Access Live Meeting home page 

 

 

 

 

9. You will land on the Live Meeting home page 

 

 

 

 

 

 

 

10. Select Meetings 

11. Choose the meeting you want to start and click on “Join 
as a Presenter” 

 

 

 

 

12. The Live Meeting console launches as well as a dialog 
box indicating your audio and recording preferences.  

Note: 
It is recommended that you join the audio conference 
portion of your meeting through the Join Conference 
which enables the audio controls from within Live 
Meeting 

 

 

If you choose to join the audio portion of the meeting via a phone using 
Ready-Access, the Chairpersons will need to enable conference call 
controls by going to the Audio menu bar option and selecting “Enable 
Conference Call Controls” from the drop down menu. 

 



 
After audio controls is enabled you will have audio conference call 
controls that will allow users to simply and effectively control an audio 
conference call directly from the Live Meeting console and provide the 
ability to perform the following integrated, in-meeting functions: 

�  Call Me – Presenters can set up the meeting so that participants 
can specify a phone number to have the service dial out to them 
and include them in the audio conference. 

�  Call Someone – Presenters in a meeting can specify a phone 
number to have the service dial out to include additional 
participants in the audio conference. 

�  Mute/Unmute (All or Individual) – Presenters in a meeting can 
mute and unmute participants in the audio conference.  This can 
be done on an individual basis or for all participants. 

�  Disconnect Participant – Presenters in a meeting can 
disconnect individual participants from the audio conference. 

 
Other features include 
 
 
Mute Everyone Except 
for Me 

�  Any presenter can use this feature. If a presenter who is not the leader 
mutes all but self, then all but that presenter will be muted – meaning the 
leader will be muted too.  

�  If a presenter enters the audio bridge from Ready-Access (and not through 
Live Meeting Join Conference feature) then he/she will be muted when using 
this feature. 

Play Name If the participant has recorded a name, it will be played to the conference leader 
only.  

End Conference Disconnects all participants from the conference 

Disconnect Participant Disconnects an individual participant from the call. This feature does not prevent 
them from dialing in again.  

Dial out to self You can have the meeting dial your phone 

Dial out to new 
participant  

As the chairperson, you can dial out to a new participant (Note: From within the 
meeting no sub-conference is setup between the chair and invitee). 

Hang up on self You hang up on yourself (end conference from drop down menu) 

Entry Announcement Allows participants to enter the meeting silently, recorded name, or a tone 
sounds indicating a new entry 

Lock/Unlock A toggle that will prevent/allow additional callers to the conference 

 
 
 
 
 



 

DOWNLOADING OUTLOOK ADD-IN 
Global Crossing recommends using the Outlook Add In with Live Meeting.  It allows you to 
bypass some of the login steps and start meetings by selecting a button on the desktop.  It also 
makes it easy to send invitations to participants, including a direct link for them to join your Live 
Meeting. . 

1. Go to www.globalcrossing.com/conferencing  

2. Go to Live Meeting in Quick Links 

3. Select Start/Manage  

 

 

 

 

 

 

4. Enter your Ready-Access® phone number 

5. Enter your access code 

6. Enter your chairperson pass code 

 

 

 

 

 

 

 

7. You will land on an interim page and will be able to take three 
actions 

�  Access Live Meeting Home Page 

�  Download Live Meeting Outlook Add In 

�  Get Your Outlook Add-In Information 

 

 

 

8. Click on Download Live Meeting Outlook 
Add In and you will land on the Add-in for 
Live Meeting 2005 page.   

9. Go to the fourth option and click on Live 
Meeting 2005 Add-in Pack 

 



 
 

10. You will land on a Microsoft Office Live 
Meeting download page.  

11. Click the download button and then click 
on the .exe file.  Follow the on-screen 
steps. 

 

 

 

 

 

 

 

 

12. Once you complete the installation 
process you will come to a preferences 
screen.  Check the information to 
ensure accuracy and make the 
necessary changes. 

 
 
 

 
 
 
 
 
 
 

 
 
 

Note: 
You will need to go back the Ready-Access log-in page 
to get your user information to enter into the 
preferences set up page. See the next section “Setting 
Up Outlook Integration”  



 

SETTING UP OUTLOOK INTEGRATION 
1. Go to www.globalcrossing.com/conferencing  

2. Go to Live Meeting in Quick Links 

3. Select Start/Manage  

 

 

 

 

 

 

 

4. Enter your Ready-Access® phone number 

5. Enter your access code 

6. Enter your chairperson pass code 

 

 

 

 

7. You will land on an interim page and will be able to take three actions 

�  Access Live Meeting Home Page 

�  Download Live Meeting Outlook Add In 

�  Get Your Outlook Add In set-up information 

8. Click get your Outlook Add-In information  

 

 

 

 

 

 

9. A screen will appear that includes your Microsoft User ID, 
password and conference center URL.  Enter this 
information in the one-time set up screen of the Outlook 
Add In.  The first part of the URL is pre-populated in the 
set-up screen; enter only the last part of the URL that is 
not already shown on the screen.  This completes the 
Outlook Add In installation. 



 
SETTING MEETING PREFERECES FOR ADD-INS 
Default meeting preferences apply when you schedule a meeting using Outlook or initiate a Meet 
Now meeting using Outlook. You can use the current default settings, or change them to meet 
your needs. 

Setting Scheduled Meeting Preferences 
Use the Scheduled Meeting Preferences tab to define default meeting entries, such as the type of 
meeting and meeting size that appear when you schedule a meeting using Outlook.  
 

1. Choose Programs from the Windows Start menu, and then 
Microsoft Office Live Meeting, Add-in Preferences. 

2. Click the Scheduled Meeting Preferences tab. 

3. To change default settings, complete the following 
selections, and then click OK 

�  Under the “Scheduled Meeting Preferences” tab there are 
three customizable areas; “Meeting Preferences”, “Audio 
Preferences” and “Default Attendee Privileges”.  

�  “Meeting Preferences” this is where you select:  

o The Meeting Type: “Auditorium Place” (for very large 
meetings) or “Web Meeting Place” (for small – medium 
meetings). It is recommended that the default be “Web 
Meeting Place” 

o Default Meeting Size: Input the number of Live Meeting 
attendees, can be customized for each meeting. 

o Meeting Language: English is currently the only supported language, however additional 
language is expected in the next revision coming in Q1 ’05.    

�  “Audio Preferences” this is where Audio information is added: 

o Audience Information: The conference bridge information for Live Meeting Attendees. Your 
information is automatically loaded. 

o Presenter Information: The conference bridge information for Live Meeting Presenters. Your 
information is automatically loaded. 

�  “Default Attendee Privileges” this is where the meeting chairperson can: 

o Select Live Meeting participants to enter meeting as attendees, presenters or both. If you plan 
on sharing a document that you want others to edit, it is best to have attendees enter the 
meeting as presenters. However multiple presenters for large meetings will be difficult to 
manage. In this case one can select “I will allow some attendees to present” this option will 
generate a separate email in addition to the outlook calendar entry that can be sent separately 
to the participants you wish to join as presenters. A typical “Default Attendee Privileges” screen 
shot is shown below 

. 

Note: 
The default settings are synchronized between Outlook and Live Meeting as follows: 

�  The audio in Outlook is synchronized with the audio in Live Meeting, using the most 
recent settings to update information;  

�  the size that you set in Outlook, overrides the size setting in Live Meeting. You can 
override default entries at the time that you schedule a meeting 



 
Setting Meet Now Preferences 
Use the Meet Now Preferences tab to set default entries for a Meet Now meeting that you initiate 
by using Outlook  

1. Choose Programs from the Windows Start menu, and then 
Microsoft Office Live Meeting, Add-in Preferences. 

2. Click the Scheduled Meeting Preferences tab. 

3. To change default settings, complete the following 
selections, and then click OK 

�  The “Meet Now” option is designed for immediate (ad-hoc) 
launch of Live Meeting. Under the “Meet Now Preferences” 
tab there are three customizable areas; “Meet Now 
Preferences for Messenger and Outlook”, “Audio Preferences 
for Messenger and Outlook” and “Default Meet Now Invitation 
Text for Outlook”.  

 

�  “Meet Now Preferences for Messenger and Outlook”  

o This is similar to the setup under the “Scheduled 
Meeting Preferences” tab except you are not 
scheduling Live Meeting but rather reserving time 
simultaneously.  A typical “Meet Now Preferences for 
Messenger and Outlook” screen shot is shown below 

�  “Meet Now Preferences” – “Audio Preferences for Messenger and Outlook” – The “Audio 
Preferences for Messenger and Outlook” are typically exactly the same as the setup under the 
“Scheduled Meeting Preferences” tab. A typical “Audio Preferences for Messenger and 
Outlook” is shown below. 

�  “Meet Now Preferences” – “Default Meet Now Invitation Text for Outlook” –  

�  One can add text in this field; this text will be included in the email invitation. Remember to 
check the “Show Audio Information in Invitation” box if you want the audio information included 
in the meeting email invitation. A typical “Default Meet Now Invitation Text for Outlook” is 
shown below. 

 

Note:  
The Meet Now preferences in the add-in are synchronized with the settings of your Meet Now 
meeting in Live Meeting. The meeting key setting is synchronized between the add-in and Live 
Meeting using the setting that is most recent. However, the duration that you set in the add-in 
preferences, overrides the same setting in Live Meeting. The settings are put into effect in Live 
Meeting when you click the Meet Now button. The key setting is put into effect in 
the add-ins when you access the preferences. 
 
You cannot invite attendees as presenters using the “Meet Now” option 



 
SETTING UP RECORD 
The Record feature is available to all users on the Professional version of Live Meeting.  It is not 
available on the Standard version. Professional version users will need to perform a one-time set-
up in Meeting preferences to make the feature appear as an option within Live Meeting.  After this 
set-up, Record can be turned on or off as needed from the Live Meeting console. 

SETTING UP RECORD FOR SCHEDULED MEETINGS 
Login to Live Meeting and select Access Live Meeting Home Page.   

1. On the Live Meeting Home page, under Meet click on “Schedule Meeting 

 

 

 

 

 

2. Once on the Schedule Meeting Page click on Meeting 
Options 

 

3. Click on Recording 

 

 

 

 

4. Make the appropriate selections based on your 
individual needs and click Set as Default.  

5. Click OK 

 
Note:  
All meetings scheduled prior to setting up record will not have the record capability.  All meetings 
after record is set up will have record capability.  If you scheduled a meeting prior to setting up 
record you can add the record functionality by editing the preference of the individual meeting 



 
SETTING UP RECORD FOR MEET NOW MEETINGS 

Login to Live Meeting and select Access Live Meeting Home Page.   

1. On the Live Meeting Home page, click on “Meet Now Details” 

 

 

 

 

 

2. On the Meet Now Details page under “Actions” click on Meet Now 
Options 

 

 

 

 

 

3. Click on Recording 

 

 

 

 

4. Make the appropriate selections based on your 
individual needs and click Set as Default.  

5. Click OK 

 

 

 

 

 

 

 

 

 

 

 



 
MANAGING A MEETING 
The Live Meeting Manager is a web-based scheduling and administration user interface for users, 
administrators, organizers, or members to quickly login to the Live Meeting Manager to join or 
initiate meetings with the Schedule Meetings or Meet Now functions. 

Use the Schedule Meeting page to easily schedule new meetings with one or more participants. 
On this page set the meeting date and time, define access options, and invite people to the 
meeting. The Meet Now command provides the fastest and easiest way to launch an immediate, 
spontaneous meeting. Meet Now uses the same online meeting room each time so that 
organizers can take advantage of previously imported content. 

 

JOINING A MEETING AS A PARTICIPANT 
There are two ways to Join a Meeting 

�  By Invitation  

�  Via The Global Crossing Web Site 

 

JOINING A MEETING: BY INVITATION 
1. The person conducting the meeting will have sent you a meeting invitation via e-mail 

2. The invitation will include all the salient information to join the meeting as seen below 

3. Click on the link to launch the web conference 

4. Dial the phone number to join audio portion of the web conference  

 

Note: 
You can join a meeting directly through a link in an invitation which is easier and more 
convenient 

Link 

Pass Code 

Phone Number 



 

JOINING A MEETING: VIA THE GLOBAL CROSSING WEB SITE 
1. Go to www.globalcrossing.com/conferencing 

2. Go to Live Meeting in Quick Links 

3. Select Join as a Participant 

 
 
 
 
 
 
 
 
 
 

4. Enter the Ready-Access phone number you used to join 
the audio conference 

5. Enter your access code you used to join the audio 
conference 

6. Enter your name 

7. Enter the meeting ID (the person conducting the meeting 
will provide a meeting ID which is required to join the 
meeting) 

8. Enter the meeting password if required (The person 
conducting the meeting may provide a meeting ID which is 
required to join the meeting; if no password has been provided you may leave this blank) 

9. Select Attendee 

10. Click join 

 
In both cases when you enter a meeting the Live Meeting 
console launches as well as a dialog box indicating your 
audio and recording preferences.  
 
Note: 

It is recommended that you join the audio conference 
portion of your meeting through the Join Conference 
which enables the audio controls from within Live 
Meeting 

 

You will now enter the meeting. 
 



 

THE MEETING LOBBY 
The Meeting Lobby helps organizers conduct 
meetings without having to explicitly send out 
invitations to attendees. Each meeting is assigned a 
static and user friendly URL for the lobby. Attendees 
can easily enter the lobby until the meeting owner 
grants them access. From the lobby, they can email 
the meeting owner to let him/her know that they are 
waiting. Once the owner enters the meeting, he/she 
is notified that attendees are waiting in the lobby. The 
owner can selectively grant/deny access to each 
attendee. The owner is also notified if new attendees 
join the meeting while the meeting is in progress.   
 
 

STARTING AN INSTANT MEETING 
1. Go to www.globalcrossing.com/conferencing  

2. Go to Live Meeting in Quick Links 

3. Select Start/Manage  

 

 

 

 

 

 

 

 

4. Enter your Ready-Access® phone number 

5. Enter your access code 

6. Enter your chairperson password 

7. Click on Log In 

8. Click on “Access Live Meeting home page 



 
9. On the Meet menu, click Meet Now which will automatically launch a 

meeting.  You will see a Meeting Entry Page that can be closed once the 
web conference begins. 

 

 

 

 

 

 

 

 

SEND INVITATIONS 
1.  Invite the people who you want to attend and present at the meeting. The e-mail invitation 

includes all meeting information including a link to the meeting.  

a. Click Send Invitations. Two options 
for sending invitations appear. 

b. If you use Microsoft Outlook®, click 
Invite Attendees. Address and send 
the e-mail message to your 
attendees. To send presenter 
invitations, repeat this process by 
clicking Invite Presenters.  

or 

2. If you do not use Outlook, scroll down to 
the “Use Browser Default” area and 
copy the attendee invitation text. Click 
Invite Attendees, and then paste the text 
into your e-mail message. Address and 
send the message. To send presenter 
invitations, scroll down the page and 
repeat this process by clicking Invite Presenters.  

3. Click Done. 



 
START YOUR “ MEET NOW”  MEETING AND IMPORT SLIDES 
1. After sending the invitations, it’s time to join the meeting. import your presentation slides and 

you’ll be ready to present. 

a. Click Meet Now. a window opens and 
instructs you to wait for the meeting 
console 

b. The meeting console appears as seen 
on the right  

 

 

 

 

 

2. From the Share menu select “Share Document To View”  

 

 

 

 

3. Locate the PowerPoint presentation you want to 
share, and then click open. You will see a dialog box 
regarding the file status. 

 

 

 

 

 

 

 

4. Expand the Resource pane and select the document you ant to 
share.  

 

 

 

 

 

 

 

 



 
 

LAUNCHING A MEETING FROM A MICROSOT OFFICE 
PROGRAM 
You can initiate ad-hoc meetings directly from any Office program such as Word, Excel, 
PowerPoint, Visio, Project and SharePoint. 
The Live Meeting Add-In for Office 
Collaboration provides the ability for users to 
instantly initiate Live Meeting from within the 
Office application. The Office document can automatically be imported into 
the Live Meeting for immediate collaboration, or shown with an application 
sharing session.  In order to use this feature you need to download the Live Meeting add in on 
www.microsoft.com.  

1. From within any Office Application click on the Live Meeting drop down menu item  

2. Select the Meet Now Option  

3. Select how you want to manage the document (application sharing, uploading into a Live 
Meeting, or meet without the document) 

SCHEDULING A MEETING  
1. Go to www.globalcrossing.com/conferencing  

2. Go to Live Meeting in Quick Links 

3. Select Start/Manage 

 

 

 

 

 

 

 

4. Enter your Ready-Access® phone number 

5. Enter your access code 

6. Enter your chairperson password 

7. Click on Log In 

8. Click on “Access Live Meeting home page 

 

 

 

 

 

9. Under The Meet heading select schedule meeting  



 
10. You will view the schedule meeting page. you will need to fill out all pertinent areas regarding 

your meeting 

 

 

 

 

 

 

 

 

11. Click Send Invitations 

 

12. The meeting notice information will open, click 
invite attendees (click on invite presenters for 
those people who will be presenting). Click 
done.  

 

 

 

 

 

 

13. You will land on the Meeting Details page where 
you can  

a. Join the meeting as a presenter 

b. Join the meeting as a participant 

c. Update the meeting 

d. Change meeting options 

e. Import a presentation 

f. Gain access to the support panel 

g. Gain access to the Record panel 

h. View recordings 

 

 

 

Note:  
The meeting ID for presenters is different than for participants.  Presenters will have the ability to 
control and manage the presentation.  For more information see the advanced features section. 



 
 

START YOUR SCHEDULED MEETING  
1. Go to www.globalcrossing.com/conferencing  

2. Go to Live Meeting in Quick Links 

3. Select Start/Manage  

 

 

 

 

 

 

 

4. Enter your Ready-Access® phone number 

5. Enter your access code 

6. Enter your chairperson password 

7. Click on Log In 

 

 

 

 

 

8. In the list of upcoming meetings, 
click the join icon next to the 
meeting that you want to join. The 
meeting will launch. 

 

 

 

 



 
 

Participant Management 
As audience sizes continue to increase and online meetings become more interactive, the need 
for simple and functional attendee controls escalates. In order to make attendee management 
more effective, Live Meeting has enhanced and upgraded many meeting controls and features. 

The Attendee Pane allows meeting participants to see who is 
attending the meeting, event, or training. The pane lists 
attendee names, their "mood," and if they are a presenter. 
Users can search for an attendee or quickly sort the list of 
attendees that appears. When using Audio Conference Call 
Controls, the “Audio” tab will also display important 
information for participants on the audio conference.   

The Attendee Profile allows meeting attendees and 
presenters to set their user profile to display information 
about themselves to other participants. Attendees can 
provide name, title, company, email, phone number, and 
attach a personal photograph.  

Attendee Permissions us the Edit Meeting Options menu to 
indicate the features that presenters want to allow attendees 
to use during the presentation. At any time during a 
presentation, these settings can be changed. 

 

When multiple presenters are working together in a meeting, one can be assigned as the Active 
Presenter. Any presenter can be made the Active Presenter, which displays their name and photo 
in the Now Presenting Pane if specified in their Attendee Profile. Rather than having to “pass the 
baton” to another presenter, Live Meeting gives users the convenience of having multiple 
presenters so that "non-Active" presenters can answer questions, or manage participants. 
Presenters can choose to promote other meeting 
participants to have presenter privileges within a 
Live Meeting. Any Active Presenter can initiate the 
Lock Content Navigation feature, which prevents 
other presenters from changing slides or pages in 
a document being shown. 

Not only are presenters able to Remove Attendees 
from Meeting, the Invite Someone function allows 
presenters to instantly send meeting invitations 
directly from the Live Meeting console. A dialog 
box allows separate presenter and attendee email 
addresses to be specified in order to have invitations sent from the Live Meeting service.  If 
necessary, additional text can also be specified to be appended to the invitation. Attendees can 
also be invited using the Send Email (to attendee) feature. This sends an email to the selected 
attendee by invoking a new email message from the user’s local email client. This capability is 
disabled if the selected attendee did not publish their email address in their attendee profile. 

Once all necessary participants have joined the online meeting, the presenter can select the Lock 
Meeting function, to add an additional level of protection. This secures the meeting and all new 
attendees attempting to enter the meeting are sent to the Meeting Lobby. 

 

 



 
Recording 
Distributing recordings of your Live Meeting sessions is a powerful method of making meetings 
useful for large groups of participants. Recordings are the next best thing to attending a Live 
Meeting session, and provide a great way to keep individuals informed, document what occurred 
at a meeting or even train new employees when you can’t be there in person. You can record part 
or all of a presentation (including the audio portion), and then make the recording available to 
others to view later at their convenience. 
 
A Live Meeting session recording is from the perspective of the attendee. It includes the slides 
that you show at the meeting, any notes you take or annotations you make on those slides, and 
any questions and answers posted to all meeting participants. (It does not include any private 
questions and answers, or chat sessions.) Live Meeting also has the capability to record the 
audio component of a meeting and synchronize it with the recorded visual portion of the session. 

 

RECORDING A MEETING 
You can quickly and easily record and 
save copies of your meetings with just a 
click of the mouse 

 

A second method of recording a meeting is as follows: 

1. In the Live Meeting console, on the Audio menu, click Join 
Conference Settings. The Audio And Recording Setup dialog box 
appears. (This dialog box also appears when you join the meeting.) 

 

 

 

 

 

 

 

 

2. Click “Start Recording” 

Live Meeting begins recording the meeting. If the 
meeting uses integrated audio conferencing, Live 
Meeting joins the audio conference by using the 
information you provided during audio setup. 
During the recording, you can monitor the recording 
status in the recording area of the Audio And 
Recording Setup dialog box. A running counter indicates how much time has elapsed during 
the recording. 

 

3. Once you have started recording the session, you can manage it by 
clicking on the drop down arrow near the record button on the 
toolbar 



 
 

4. Or, you can click the Record Settings” option and 
manage your meeting from the dialog box. 

 

 

 

 

 

 

STOPPING A RECORDING 
Once you stop a recording, you have three options 

a. Save Recording – This saves your 
recording. Live Meeting will post recording 
within 24 hours  

b. Discard Recording – This deletes your 
recording. Once discarded the recording 
cannot be retrieved 

c. Resume Recording - continues recording 
 

VIEW A RECORDING  
After you save a recording to the Live Meeting server, you can access the recording by using Live 
Meeting Manager, and then view the recording in your Web browser. 

 
1. On the My Home page of Live Meeting Manager, in the Manage area, 

click Recordings.  
 
 
 
 
 
 
 
 
 
2. In the Recordings list, click the icon to the left of the recording that you want to view.  
 
 
 
 
3. On the View Recording Info page, in the View recording in 

basic format area, click the icon in the View column. 
 
 
 
 
The recording begins playing in a separate Web browser window. Meeting organizers can always 
access recordings of their meetings by using Live Meeting Manager.  



 
SENDING AN INVITATION TO VIEW RECORDINGS 
By using Live Meeting Manager, as a meeting organizer or a presenter who has been granted 
permissions, you can send e-mail invitations to others who do not already have access to the 
recording. The e-mail recipient can click a link in the invitation to view the recording. 

 

1. On the My Home page of Live Meeting Manager, in the 
Manage area, click Recordings.  

2. In the Recordings list, click the subject of the recording 
that you want to view. 

3. The Edit Recording Details page appears. 

4. Optionally, make changes that you want applied to the 
recording access control and to the download options 
for the people you want to invite to view the recording. 

5. In the Invitees box, type the full e-mail address of each 
person you want to invite  

6. In the Message text box, type any custom message that 
you want to appear in the invitation. 

7. Click Send Invitations. 

 

DELETING A RECORDING 
When the content of a recording is out of date, you can delete it. 

1. On the My Home page of Live Meeting Manager, in the Manage area, click Recordings. 

2. On the Manage Recordings page, select the Delete check box to the right of each 

3. recording that you want to delete. 

4. Click the Delete link. 

 

 

 

 

 

 

 



 
WORKING WITH PRESENTATIONS 
A critical component of your meeting is the presentation — the slides you show to attendees. 
With Live Meeting, you can import PowerPoint presentations and select and show the slides you 
want to use. In addition, you can insert new slides “on-the fly” including interactive Polling slides, 
White Boards, and Text slides. To help you maintain your presentation, Live Meeting provides a 
set of tools you can use to duplicate, delete, and rename presentations and slides.  Typically, to 
work with a presentation you perform the following tasks: 

�  Import a presentation 

�  Choose (load) the presentation into the console 

�  Select and show slides 

�  Insert new slides as needed 

�  Maintain presentations and slides 

 
Before or after the meeting, you might take advantage of other features that let you 

�  Start a cycling slide show (presenter only) 

�  Review slides at your leisure 

�  Print a PDF of the presentation 

Importing A Presentation 
Before you begin your meeting, import the presentations that you want to use. Organizers can 
import presentations without joining the meeting, or as a presenter, you can import presentations 
after you join the meeting. 

To Import A Presentation 

1. After you have launched a meeting, click the Import 
presentation button on the toolbar 

 
 
 
 
 
 
 
 

Or, on the toolbar, click Share and select Share Document to View 
or Share Document to Edit 

 
 
 
 
 
 
 
 

2. Locate the presentation you want to import, and 
double click it. If you import a PPT file, the process 
automatically converts it for use with Microsoft Office 
Live Meeting, creating a PWP file.  

 
 



 
 
 

3. Click Done 

Choosing A Presentation 

If a presentation is not loaded to the console, or if you want to choose a different presentation, 
complete the following procedure. After you choose a presentation, all of the slides that it 
contains appear in the Presentation panel in the console. 
 

1. Chose the presentation you want to display by double clicking 
it in the Resources pane.  

 

 

 

 

 
 

 
 

 

INSERTING NEW SLIDES 
In addition to the slides that you create by using PowerPoint and then import to the meeting, you 
can insert new slides into your presentation at any time. 
 

 

A White Board slide is a blank image slide upon which you can draw, add text and stamps, 
and highlight information by using the Annotation tools. For example, you might want to 
insert a White Board slide to quickly create a flow chart to illustrate a point 

 

A Web slide shows a Web page to the attendees, allowing them to access the page and click 
the links on the page to navigate to different information. This type of slide is great for posting 
surveys and online registration forms in your meeting 

 

A Text slide is a blank editable text slide upon which you can type, copy, and paste text. For 
example, you might want to paste a project outline from another application, and then work 
on it in the context of your meeting. 

 
A Polling slide is a great way to solicit feedback from attendees by allowing them to select 
from several responses to a question. 

 
Snapshot slide shows a captured screen shot from your computer, such as a captured 
spreadsheet or graphic. After you create a Snapshot, you can use the Annotation tools to 

If you are the only presenter in the meeting, the imported presentation is automatically 
loaded into the meeting. If another presenter is in the meeting, the presentation is not 
loaded, so as not to disrupt a presentation in progress, but is available when you 
Choose a presentation. 

Note:  
Before you can choose a presentation, you must import 
it to the meeting. All imported presentations appear in 
the Choose Presentations window. If a meeting is not 
in progress when you import a presentation, it is 
automatically selected and loaded into the console. For  
more information about importing, see the previous 
section, “Importing a presentation.” 



 
add annotations to it. 

 

A Sharing slide is not like the other slides that you create. In fact, a Sharing slide is really not 
a slide, but a way for you to share a view of your computer or the use of an application or 
your desktop with an attendee 

Inserting White Board Slides 

1. In the Presentation panel, click the slide that you want to insert the 
new slide after. 

 

 

2.  On the Insert menu, click White Board slide, or click the Insert White 
Board slide button on the toolbar.  

 

A blank image slide appears on which you can work. In addition, the Annotation tools 
appear on the toolbar. 

 

 

 

 

 

 

 

3. Click the Annotation tool that you want to use, and then click the area of the slide where 
you want to apply it. For more information about using the tools, see “Working with 
Annotation tools.” 

 

Note: 
Microsoft Office Live Meeting Provided By Global Crossing identifies the first White Board 
slide that you create as White Board A in the list of slides in the Presentation panel. It 
identifies the second slide as White Board B, and so on. You can rename the slide if you want. 
For more information about renaming, see “Renaming slides” 

Note: 
If you click a link and the Microsoft Office Live Meeting Provided By Global Crossing controls 
disappear, you have 
lost contact with Microsoft Office Live Meeting Provided By Global Crossing. If you want to 
show a Web page and its links 
to attendees but deny the audience access to the links, create Sharing slides instead. 



 
Inserting Web Slides 

A Web slide lets you display a Web page to the attendees, allowing them to view the latest 
available World Wide Web information and avoiding the need for you to create slides that 
duplicate information already on your intranet. The links on the Web slide shown to attendees are 
active—an attendee can click a link and immediately display the associated page. You could 
show a Web slide with a link to your e-mail address or links to documents that provide more 
information. (A link to a document will open the document in the browser or in a helper 
application, or it will ask the audience member to save the document.) You can also use a Web 
slide to let the audience easily navigate to Web-based applications, such as a corporate help 
desk or phone directory 

1. In the Presentation panel, click the slide that you want to insert the 
new slide after. 

 

 

 

 

2. On the Insert menu, click Web slide, or click the Insert Web slide 
button on the toolbar. 

 

 

 

3. Enter the Web address of the Web page that you want to show. 4 Make sure the Bypass 
Safety Check box is not selected, and then click Verify Web Slide. A check page 
appears. 

 

 

 

 

 

4. After the verification completes, click Create Web Slide. Live Meeting identifies the first 
slide that you create as Web A in the list of slides in the Presentation panel. It identifies 
the second slide as Web B, and so on. You can rename the slide if you want. For more 
information about renaming, see “Renaming slides.” 

Note: 
When you create a Web slide, you have the option of bypassing the safety check. 
It is recommended that you do not bypass this check. If you enter a non-existent 
URL and show the Web slide during a presentation, you could lose contact with 
Microsoft Office Live Meeting Provided By Global Crossing. 



 
Inserting Text Slides 

A Text slide is a blank editable text slide upon which you can type. For example, if you want to 
type new information that is available to the audience to copy and paste, such as an action item 
list, you can create a Text slide. When you create and work with a Text slide, you can use the 
Edit menu commands to copy, paste, cut, and delete text. 
 
 

1. In the Presentation panel, click the slide that you want to insert the 
new slide after. 

 

 

 

 

2. On the Insert menu, click Text slide, or click the Insert Text slide 
button on the toolbar. A blank area in the slide display area of the 
console appears for you to type your text.  Live Meeting identifies the first Text slide that 
you create as Text Slide A in the list of slides in the Presentation panel. It identifies the 
second slide as Text Slide B, and so on. You can rename the slide if you want. For more 
information about renaming, see “Renaming slides.” 

 

 

 

3. Type the text that you want to appear on the slide. 

4. If you want, use the Edit menu commands to help you create the text. For example, to 
copy text that you type, highlight the text, and then on the Edit menu, click Copy. To 
paste the text, click the mouse in the location on the slide where you want to paste the 
text, and then on the Edit menu, click Paste. 



 
Inserting A Snapshot Slide 

Snapshot slide shows a captured screen shot from your computer, such as a captured 
spreadsheet or graphic. After you create a Snapshot, you can use the Annotation tools to add 
annotations to it. 

1. In the Presentation panel, click the slide that you want to insert the new slide after. 

2. Start the application and display the screen that you want to capture as a snapshot. 

3. On the Insert menu, click Snapshot slide, or click the Insert Snapshot slide button on the 
toolbar. The Snapshot frame appears. 

 

4. Navigate to the shot that you want to capture, and then drag the frame to position it on 
the screen. You can change the size of the Snapshot frame by dragging the corners of it. 

5. Click the Snap button. The slide is inserted into the slide set and the Snapshot slide 
appears in the Presenter Console. The first Snapshot slide that you create is identified as 
Snapshot A. The second is identified as Snapshot B, and so on. You can rename the 
slide if you want. 

6. Repeat Steps 4 and 5 to create other Snapshots. 

7. When you finish, click the Close button that appears on the Snapshot frame. 

 

 
 

 

 

 

 

 

 

Note: 
A Sharing slide is not like the other slides that you create using PowerPoint or the Insert 
Slide  buttons. In fact, a Sharing slide is really not a slide, but a way for you to share a 
view of your computer or the use of an application or desktop with an attendee.  



 
Presenter Tools 
Whether brainstorming with a colleague across the world or presenting a product launch to an 
audience of up to thousands, Live Meeting offers a rich set of tools that allow users to customize 
the level of interactivity needed with their meeting participants. By engaging users in a powerful 
and interactive virtual meeting room environment, Live Meeting participants are able to leverage 
an array of customer-focused features that were specifically designed to make it the most 
effective online meeting solution in the industry.  Your small meetings and large-scale 
presentations are now easier to manage — with enhanced presenter control tools. 

Document Viewer 
Setting up meeting content is easy with the Live Meeting Document 
Viewer. It allows the import of any document type that can be printed. 
Presenters can drag and drop documents directly into the Live Meeting 
console to bring them into an online meeting quickly and easily. For 
convenient storage, documents remain in the virtual meeting room per the 
content expiration policies established by the Live Meeting administrator. 
This gives users readily available access to previous or future meeting 
content regardless of which computer they are working from. 

PowerPoint Viewer 
In addition, Live Meeting’s PowerPoint Viewer displays Microsoft® PowerPoint slides with full 
support for animations and transitions, allowing presenters to take advantage of these effects in 
the online meeting environment. That helps to focus audience attention and make presentations 
more engaging for remote participants. Animation support lets presenters or organizers select 
slide elements to appear at certain times and in a particular order (e.g., fly in, fade, etc.). 
Transitions are supported for effects when moving from slide to slide (e.g., wipe, cover, push, 
etc.) and Full Screen Mode allows participants to view the slide so that it uses up the entire 
screen 

Remote Control 
Remote Control allows the presenter to hand control of any 
document, application, or even their desktop to any remote 
participant. This means that both the presenter and the participant 
have full control of that application. This can be especially useful in 
environments where interactive collaboration with co-workers is 
necessary.  

1. From the Attendee Pane the presenter highlights a meeting 
participant 

2. The presenter right clicks on the mouse which launches a pop 
up box and the presenter selects “Make A Presenter” 

 

Similarly, Remote Assistance allows presenters in a Live Meeting to initiate application or desktop 
sharing on a remote participant’s desktop. This is particularly useful in helpdesk or customer 
support roles. For security reasons, the remote participant can grant or deny access to the 
session initiator.   

Drag-and-Drop 
any Printable 
Document from 
Your Desktop 

 into 



 
Resource List 
The Live Meeting Resource List provides a listing of all documents, 
presentations, and interactive slides available in the Live Meeting console, 
giving presenters immediate access to an organized inventory of meeting 
content.  

The resource List is located in the upper left hand corner of the Live 
Meeting page 

 

 

Thumbnail Navigation 
To further simplify content navigation, the Thumbnail Navigation 
feature provides a thumbnail view of each page or slide for all 
loaded documents and presentations.  To activate the Thumbnail 
Navigation option: 

 

 

 

 

1. Click on the View menu option 

2. Click on Show Thumbnails 

 

 

 

POLLING 
Polls allow presenters to receive instant feedback from 
their audience in real-time, as seen in the 
accompanying screen shot. Polls can be created in 
advance using Microsoft PowerPoint or during the 
meeting by clicking the poll button. The poll will be 
instantly displayed or hidden (based on the presenters’ 
preference) and audience votes are tallied 
dynamically. At the end of the session a polling report 
can show how specific individuals voted as well as 
aggregate total 

 

 

 

 

 



 
Inserting Polling Slides 

Polling slides are a great way to solicit feedback from attendees by allowing them to select from 
several responses to a question. You can create Polling slides ahead of time or insert them on-
the-fly during your presentation. 

 
 
 
 
 
 
 
 
 
 
 

1. In the 
Presentation 
panel, click the slide that you want to insert the new slide after. 

 

 

 

 

 

 

2. On the Insert menu, click Poll slide, or click the Insert Poll 
slide button on the toolbar.  

3. In the Question box, enter the question to which you want 
attendees to respond. For example, for a large Sales 
meeting you might ask “Indicate the region that you 
represent.” 

4. In the Choices area, enter one selection for each line. For 
example, in response to the region question, you might 
enter North on one line, South on the next line, and so on. 

5. Click OK. The Polling slide appears in the console and 
Polling buttons appear in the toolbar. 

 

 

Depending on the selections that you make using the Polling buttons on the toolbar, the 
polls are either opened or closed and the results either appear or are hidden from the 
attendees. For more information about opening and closing the poll, showing results, and 
editing a Polling slide, see the next three sections. 
 
Live Meeting identifies the first Polling slide that you create as Polling Slide A in the list of 
slides in the Presentation panel. It identifies the second slide as Polling Slide B, and so 



 
on. You can rename the slide if you want. For more information about renaming, see 
“Renaming slides.”  

 

Opening And Closing Polls 

After you insert or show a Polling slide, you need to open the polls so that attendees can vote. If 
you want to prevent further voting, close the polls. 

1. Select or insert the Polling slide that you want to show. 

2. To open the polls, click the Open Polls button on the toolbar. 

3. To close the polls, click the Close Polls button on the toolbar. 

 

You can also double-click the Polls open/close status that appears below the Polling slide in 
the slide display area. 

Showing Or Hiding Polling Results 

If you want attendees to see the results of everyone voting on a Polling slide, you can choose 
to show them. Likewise, you can hide the results at anytime. 

 

Showing Polling Results Hiding Polling Results 

1. Select or insert the Polling slide that you 
want to show. 

2. Make sure that the polls are open so that 
attendees can vote. (For information 
about opening the polls, see “Opening 
and closing the polls”) After an 
appropriate time, you might want to close 
the polls to stop attendees from voting or 
changing their votes. 

3. To show the results to attendees, click 
the Show Polls button on the toolbar. The 
slide shows the percentage of attendees 
selecting each choice. Live Meeting 
continuously updates the results as long 
as attendees vote, the polls are open, 
and you show the Polling slide. The 
choice, No Vote, indicates the 
percentage of attendees who did not vote 

1. To hide the results from attendees, 
click the Hide Polls button on the 
toolbar. 

2. On the Edit menu, click Meeting 
Options. 

3. Clear the Annotate/Edit slides check 
box. 

Note:  
The Show/Hide feature is directly related to the Annotate and edit slides check box in the 
Meeting Options. If you select this check box, you cannot hide polling results from attendees. 
Consequently, the Show/Hide buttons are not available. However, if you select this check box, 
attendees as well as presenters, can open and close the polls. For more information about 
meeting options, see “Setting meeting options.” 



 
Clearing Polling Results 

You can clear the polling results on an individual slide or clear all Polling slides in a 
presentation at the same time. It is often helpful to clear results if you are using the same 
presentation for multiple audiences at different times, or if you want to clear all votes and 
query attendees again. 

1. Show the Polling slide that you want to clear. 

2. Click the Clear Polls button on the toolbar. All results are reset to 0. 

or 

1. On the File menu, click Choose presentation, or click the Choose Presentation button on 
the toolbar. 

2. In the Presentation area of the Choose Presentation 
window, click the presentation that has the slide that 
you want to clear. The slides appear in the Slides area 
of the window. This area also contains the Slides 
toolbar. 

 

 

 

 

3. Scroll through the slides until the one that you want to clear appears. 

4. Click the slide, and then click the Clear Polls button on the Slides toolbar. 

You can clear all polling slides through the following procedure: 
 

1. On the File menu, click Choose presentation,  

 

 

 

 

or click the Choose Presentation button on the toolbar. 

 

 

2. In the Presentation area of the Choose Presentation window, click 
the presentation that you want to clear. 

 

 

 

 

 

3. Click the Clear Polls button on the Presentations toolbar. A message 
asks you to confirm that you want to clear all slides in the presentation. 

4. Click OK. 



 
Editing A Polling Slide 

You can change the question or choices on a Polling slide at any time. 

1. Select the Polling slide that you want to edit. 

2. Click the Edit Poll Slide button on the toolbar. The current 
question and choices appear. 

3. Edit the question and choices as required, and then click OK. 

 

 

 

Application And Desktop Sharing 
Broadcast any visuals, applications, web pages, documents, or software to remote participants in 
real-time with Live Meeting Application and Desktop Sharing. Allow audience members to follow 
along with mouse movements and keyboard inputs by presenting live from the desktop. Live 
Meetings lets users show anything on their computer instantly to remote audiences. Presenters 
can choose to share their whole screen or only a portion to keep the audience focused on the key 
information. By sharing their desktop, presenters are able to engage with their audience in 
interactive product or software demos from any location. 

 

1. Click Share on the tool bar and select “Share Application” 

 

 

 

 

 

 

2. Select the method of sharing your documents 

a. The Sharing Frame lets presenters select a 
specific area of their desktop they would like to 
share with meeting participants. For example, if 
there is only a portion of a confidential Word or 
Excel document the presenter would like to 
show to an audience, Live Meeting lets them 
select and share only that portion, while keeping 
the rest of the document private and unseen.  

b. Desktop sharing Show and share visuals, 
applications, web pages, files or software to participants in real time. Meeting attendees 
can see exactly what you are doing—including your mouse movements and keyboard 
inputs 



 
These five configuration options may improve Sharing performance: 
�  Turn off unnecessary applications and services during your Sharing session. Applications like 

Word, Excel, Outlook, RealPlayer, etc. reduce your computer©s available system resources 
even if they are running unused in the background. If you will not use an application during 
your Sharing demonstration, turn it off.  

�  Use the Display Properties control panel to the color saturation (number of colors displayed) 
of your monitor. Lower values use less resources. To change this setting, right-click on a 
blank area of your desktop and choose Properties. Select the Settings tab. The Live Meeting 
Sharing application works best when Medium (16-bit color) or Low (256 colors) settings are 
used.  

�  Windows XP users may want to disable desktop Visual Effects. Right-click on My Computer 
and select Properties. Select the Advanced tab. Under Performance, click the Settings 
button. Select the Visual Effects tab and choose "Adjust for best performance". Click OK. 
(This option is not available on non-XP systems.)  

�  Windows NT4/2000/XP use can change System Performance Options to provide additional 
resources to background applications. (This option is not available on Windows 95/98/ME 
systems.) Right-click on My Computer and select Properties. Select the Advanced tab. Under 
Performance, click the Settings button. On the Advanced tab, under Processor scheduling, 
select Background services. Because the Live Meeting Sharing application is a background 
process, giving it equal processor time can improve Sharing performance.  

�  Turn off Graphics Hardware Acceleration. (This option is not available on WindowsNT4.) In 
the Display Properties control panel go to the Settings tab, click on the Advanced button, then 
click the troubleshooting tab. Move the Hardware Acceleration slider bar to None. When your 
meeting is over, you may want to turn Graphics Hardware Acceleration back on.  

Passing Sharing Control To An Attendee 
Using any of the three sharing methods, you can also allow an attendee to take control of one or 
more applications on your computer. 

1. Choose to share the Sharing frame, an application, or the desktop, as described in the 
previous procedure.  

2. Click the Start button to start sharing. (See above graphic) 

3. Click the Give Control button. (See above graphic) 

4. The Give Control to Attendee window appears.  

5. Select the person to whom you want to give control, and then click 
the Select button.  

6. A message on the status bar appears at the bottom of the 
console, indicating that the attendee is the controller.  

 

Note: 
The ability to give control to an attendee is available if purchased as part of your Live Meeting 
service and if the person who schedules the meeting enables it. If the privilege is not allowed, 
then the Give Control button does not appear when you share. For information about setting 
meeting options, see the Scheduling Meetings section. 



 
7. The attendee can now use the selected items on your computer. For example, if you give 

an attendee sharing control of Microsoft Word, all attendees see the controller’s use of 
Word. 

8. To retake control, click the Take Control button or press the Esc key. 

Receiving Sharing Control  
As an attendee, the presenter can choose to give you control of the items within the Sharing 
frame, a specific application, or his or her entire computer desktop. At any time, the presenter can 
take back control from you. 

1. Wait for the presenter to show a Sharing slide. A message on your console indicates that 
you should wait for sharing to begin.  

2. After the presenter gives you control, your name appears as the controller in the status 
bar of the console and a view of the presenter’s application or desktop appears in the 
slide display area, depending on what level of sharing the presenter grants to you. 

 
 

 

 
 

3. Use the contents in the slide display area to manipulate data and show information just 
as you would on your own computer. Attendees see all of your actions.  

4. At any time, the presenter can retake sharing control. At that time you can no longer 
control the items on the presenter’s computer. 

WHITEBOARD 
A whiteboard slide is a blank collaborative slide that can be marked up by participants by using 
the annotation tool (see next section).  To launch a whiteboard slide do the following: 

1. On the menu toolbar click Share and Whiteboard 

2. A blank slide appears in the presentation window and you are able to 
draw, add text or highlight information using the annotation tools 
described in the next section. 

 

 

 

Working With Annotation Tools 
Use the Annotation tools to add text, draw lines and shape, and add stamps to White Board, 
Snapshot, or image slides. You can also highlight areas of importance by using the pointer or 
highlighter. After adding annotations, you can move them, delete them, or clear all annotations at 
once. You can also use Edit menu commands to copy, paste, and delete annotations. 
 

1. Show an image or White Board slide with which you want to work. The Annotation tool 
buttons appear in the toolbar. 

 

Note: 
To expand the view, hide all the console panels by clicking Hide Panels on the View 
menu or by pressing Ctrl+H. After you finish sharing, click Show Panels on the View 
menu. 



 
2. Click the tool with which you want to work, and then click the area on the slide where you 

want to use the tool. See the following table for information about each tool. 

Tool Use 
  Use the Select Annotations tool to 
select an annotation that you added. 

To move an annotation, delete it, or use it 
with Edit commands such as Copy, you 
must first select the annotation by using this 
tool. 

Click the tool to select it, and then click the 
annotation with which you want to work. 

 

Use the Pointer tool to point to 
information on the slide, similar to 

how a laser pointer works. 

Click the tool, and then click an area on the 
slide and drag the mouse. Attendees see a 
red dot that follows the path of the pointer as 
you drag your mouse across the slide 

Use a Draw 
Freehand tool to 
draw lines, arrows, 
and shapes. 
 

To select a drawing tool, click the arrow that 
appears next to the Draw Freehand button, 
and then click the tool that you want; click the 
area on the slide where you want to draw. 
After you select a tool, its button appears in 
the Annotation toolbar and remains there until 
you select a different tool. 

Use the Highlighter tool to highlight 
an area, similar to how you would 

use a yellow marker to underline a passage 
in text. 

Click the tool, click an area on the slide, and 
then drag the mouse to highlight the area  

Use a Stamp tool to 
add an arrow, check 
mark, or X to the 
slide 

To select a stamp, click the stamp arrow that 
appears next to the stamp button, and then 
click the tool that you want; click the area on 
the slide where you want to add a stamp. 
After you select a stamp, its button appears in 
the Annotation toolbar and remains there until 
you select a different tool.  

Use the Draw Text tool to add text to 
a slide. 

Click the tool, and then click the area on the 
slide where you want to add the text; a text 
box appears; type the text. Before clicking off 
of the text box, you can edit the text by 
clicking the text that you want to change and 
then typing the new information. 

Use the Clear Annotation to remove 
all annotations from a slide. 

Click the tool, and then click OK to remove all 
annotations from the slide.  

 



 
Clearing All Annotations In Presentations 
It is often helpful to clear (remove) all annotation in a presentation if you are using the same 
presentation for multiple audiences at different times or if you just want to start “clean” with  
your image or White Board slides 
 

1. On the File menu, click Choose presentation,  

 

 

 

 

 

or click the Choose Presentation button on the toolbar. 

 

2. In the Presentation area of the Choose Presentation window, click the 
presentation that you want to clear. 

3. Click the Clear Annotations button on the Presentations toolbar. 

 

 

 

 

Clearing All Annotations On A Specific Slide 
Although you can delete individual annotations on a slide, at times you might want to delete all 
annotations at once. To do so, you can clear them. For example, if you have marked up an image 
or White Board slide and it has become difficult to read, you can clear all annotations. You can 
clear annotations from the console for a loaded presentation or you can clear them for any 
imported presentation by using the Choose Presentation window 

1. Show the slide you want to clear  

2. In the Presentation area of the Choose Presentation window, click the presentation that 
you want to clear. 

3. Click the Clear Annotations button on the toolbar. 

Or, 

1. On the File menu, click Choose presentation, or click the Choose Presentation button on 
the toolbar. 

2. In the Presentation area of the Choose Presentation window, click the presentation that 
has the slide that you want to clear. The slides appear in the Slides area of the window. 
This area also contains the Slides toolbar. 

3. Scroll through the slides until the one that you want to clear appears. 

4. Click the slide, and then click the Clear Annotations button that appears on the Slides 
toolbar. 



 
Moving Annotations  
After you add an annotation to a slide, you can move it to another location on the slide if you 
want. 

1. Show the image or White Board slide with which you want to work. 

2. Click the Select Annotation tool button on the toolbar. 

3. Click the annotation that you want to move, and drag it to the new location. 

Deleting Annotations  
If you want to remove an annotation, you can delete it. 

1. Show the image or White Board slide with which you want to work. 

2. Click the Select Annotation tool on the toolbar, and then click the annotation that you 
want to delete. 

3. Press the Delete key. 

Copying, Cutting, And Pasting Annotations  
Take advantage of Edit menu commands to quickly copy, cut, and paste annotations. 

1. Show the image or White Board slide with which you want to work. 

2. Click the Select Annotation tool on the toolbar. 

3. Select the annotation that you want to copy. 

4. On the Edit menu, click Copy or Cut, depending on which command you want to use. 

5. Click the location on the slide where you want to paste the annotation, or to paste onto a 
different slide, select and show that slide. 

6. On the Edit menu, click Paste. 

Managing Resources 
Use the Manage Resources window to maintain your presentations and slides. You can rename, 
delete, clear polls, and clear annotations for presentations or individual slides. You can also 
create a blank presentation for use with the Insert slide buttons, save changes to a presentation, 
or revert to a previously saved version of the presentation. 



 

To Display Manage Resources 
1. On the Tool menu, click Manage Resources and the Managed 

resources window opens. Once opened you can manipulate the 
document in any manner necessary like moving the order of the 
slides, changing names, etc. 

 

 

 

 

Creating A Blank Presentation 
If you want to create a new presentation after you join a meeting, you can create a blank 
presentation and then use the Insert slide buttons to add slides to it. 

 

1. On the Tools menu, click Create a Blank Presentation  

 

 

 

 

 

 

 

2. In the New Resource window give the blank 
presentation a name and Click OK. 



 
Renaming A Presentation 
You can rename any imported presentation. This feature is useful for working with duplicated 
presentations 

1. On the Tools menu, click Rename Resource,  

 

 

 

 

 

 

2. Enter a new resource name in the Rename Resource 
pop up box 

3. Click OK. 

 



 
Deleting A Presentation 
If you are done using an imported presentation and do not want to show it again, you can delete it 
from the meeting. After deleting it, you will need to import it again if you want to use it. 
. 

1. On the Edit menu, click Delete,  

 

 

 

 

 

 

2. You’ll get a warning. Click OK to 
Delete the Selected Presentation 
button.  

 

 

GENERATING MEETING REPORTS 
Meeting reports provide both summary and detailed information about the meetings that take 
place in Live Meeting: 

�  Meeting List report. Lists the meetings and attendance for a given time period. 

�  Meeting Attendance report. Lists users and the role they played (presenter or attendee), the 
browser used, the time they arrived, and the duration of their attendance for a meeting. It 
also includes a list of e-mail addresses and company names if attendees and presenters 
were required to enter this information. 

�  Meeting Poll report. Indicates how each person attending the meeting voted in response to 
each Polling slide that was shown. It also includes a percentage summary of the votes. 

�  Organizers can download a real-time report of all registrants for a particular instance of an 
event.  

�  The report is a standard comma separated value (.csv) file format for easy sorting in 
Microsoft Excel and importing/exporting into other systems such CRM or database 
applications.  

�  This report will show summary data about the event and all related information for each 
registrant of the event including contact information, demographics, pre-event questions, 
attendance questions, and survey questions.  

�  This report will also show if each registrant actually attended the event, and will simplify post 
event follow-up with the audience.  

�  Users will have increased event management capabilities so that entire events or selected 
instances of an event can be removed from the Live Meeting registration system.  

�  If an event needs to be cancelled or rescheduled, organizers now have an even easier 
means of managing this process. When combined with the new Report Download feature, 
organizers are in complete control of event management and audience communications.  



 
�  When an event or instance of an event is removed from the system, all associated registrant 

data is also removed and can not be recovered. Please remember to download the registrant 
report prior to removing any events from the system. 

To Generate A Meeting List Report 
1. On the View menu, click Reports. 

 

 

 

 

 

 

 

 

2. Click the Meeting List report. 

 

 

3. From this report you can generate other reports, or change the report date range to 
generate new information 

 

 

4. Make your selections and click View. 

 



 

 

To Generate A Meeting Attendee Report 
1. On the Meeting List report, click the meeting ID for which you want a report. 

 

2. A report of attendees appears outlining  

�  Day of meeting 

�  Name of participant 

�  Role of participant 

�  The time the participant arrived 

�  The time the participant spent in 
the meeting 

�  The participant’s IP address 

�  The participant’s company 

�  The browser the participant 
used during the meeting 

To Generate A Meeting Poll Report 
1. On the Meeting List report, click view Poll icon next to the meeting 

that you want to review. If a View Poll icon does not appear next 
to a meeting, polls were not conducted. 

 

 

 

 



 
2. A report of attendees appears 

outlining 

�  Day of meeting 

�  Name of participant 

�  Role of participant 

�  The time the participant arrived 

�  The time the participant spent in 
the meeting 

�  The participant’s company 

�  The question browser the 
participant used during the meeting 

To Generate Recording Reports 
Recording reports help you monitor the number of recordings completed and how often they are 
viewed: 

�  Recording List. Shows the recordings available for a given time period and the number of 
times each one was viewed.  

�  Recording Details. Lists users who viewed a recording, and indicates when the user viewed 
it, the user IP address, company, and browser. 

To Generate Recording List 
1. On the View menu, click Reports. 

 

 

 

 

 

 

 

2. Click the Recording List report. 

 

 

 

 

 

3. From this report you can generate other reports, or change the report date range to 
generate new information 

 

 



 

 

4. A report of recorded meetings appears outlining 

�  The start time of meeting 

�  Recording ID 

�  Organizer 

�  Bill To information 

�  How many times the recording 
was viewed 

�  The duration of the session 

�  The file size 

To Generate Recording Details Report 
1. On the Recording List report, click the Recording ID of the recording that you want to 

view in detail. 

 

 



 
Printing A Report 
After you generate a report, you can print a copy of it  

1. On your browser’s File menu, select Print 

 

2. Select the options that you want to use, and then click Print. (Options in the Print dialog 
box will vary. 

To Save A Report n CSV Format 
After you generate a report, you can save it as a comma-separated (CSV) file 

1. On the reports page click CSV 
format 

 

 

 

 

2. A dialog box will appear, click Save to save the file 
on your computer 

 

 

 

 

 

3. Navigate to the location where you want to save the 
file and clock OK 

 

 

 



 
To Open The File In Microsoft Excel 
After you generate a report, you can save it as a comma-separated (CSV) file 

1. On the reports page click CSV 
format 

 

 

 

 

2. A dialog box will appear, click Open.  

 

 

 

 

 

 

3. The file appears in Excel format. 

 

 

 

INTERACTING WITH ATTENDEES 
After you join a meeting as a presenter, you can use Global Crossing Office Live Meeting to 
continually interact with attendees by monitoring feedback, seeing who is attending, chatting, and 
working with attendee questions. At your discretion, you determine the level of attendee 
participation by providing one or more features to attendees.  

The Seating Chart 
The Seating Chart panel provides a view of the number of attendees and their feedback. In the 
following example, the presenter requests feedback for the pace of the meeting. 

 

In the Seating Chart panel, click the Feedback arrow, and then click the color that represents your 
feedback. 

Note:  
To open the file in Excel, you must use Internet 
Explorer as your browser and have Excel 
installed on your computer. 
 



 
Seeing Who Is Attending The Meeting 
Use the Attendees panel to see a list of who is attending the meeting, to initiate a chat (more 
about chat in the next section), and if necessary, to eject an attendee from the meeting.  

1. To find an attendee, enter the first few letters or the name of the 
person who you want to locate in the Find box. 

2. To sort the list, click a category head, such as Name. 

3. To eject an attendee from the meeting, right-click the attendee 
name, and then click Eject. The attendee is disconnected from the 
meeting 

 

Chatting 
Live Meeting includes a Chat tool with which participants can conduct separate conversations 
away from the larger group. Chats are a useful way for presenters to communicate with 
participants during a meeting, such as when a presenter suggests a break-out session to discuss 
a specific issue with another participant. In some cases, you might also want to allow attendees 
to chat with one another. When Chat is activated, each participant can have multiple one-on-one 
chat sessions open. Any participant can block individual participants from chatting with him or her 
by right-clicking the name of the participant in the Attendees pane and then clicking Block Chat. 

To activate chats for your meeting, follow these steps. 

1. On the Attendees menu, click Attendee Permissions.  

 

 

 

 

 

 

2. In the Interact area of the Attendee Permissions dialog box, click 
the Chat with other attendees option. 

 

 

3. Click Close. 

 

 

 

To chat with another participant, follow these steps. 

1. In the Attendees pane, right-click the name of the person with 
whom you want to chat, and then click Chat. A Chat box 
appears on both your computer and the person’s computer 
with whom you select to chat. The person’s name appears in 
the title bar. 

 



 
2. Enter your comment or question in the text entry area at the bottom of the Chat box, and then 

click Send. 

 

3. The chat between you and the other participant appears at the top of the Chat box. 

Working With Questions 
The Questions and Answers panel provides a convenient and efficient method for attendees to 
send questions to you during a meeting. After you receive a question, use the Question Manager 
to review and respond to the question.  

To respond to a question 

1. Click the Questions and Answers panel menu button  I and then click Question 
Manager. 

2. The Question Manager appears, listing all questions received from attendees. 

 
3. Click the question that you want to answer. You can respond to questions in a variety of 

ways.  

a. Privately   

b. Post the answer to everyone   

c. Allow the person to take the floor and address all attendees  

d. Dismiss the question.  

4. You can respond in any of the above mentioned ways by first typing in your answer and 
then selecting the appropriate button. 

 

Note: 
If you close the Questions and Answers panel, you can still monitor your questions by using 
the status bar in the lower left corner of your console. Double-click the questions indicator to 
open the Question Manager. 



 

ALLOWING FEATURES FOR ATTENDEES 
Use the Meeting Options to indicate the features that you want to allow attendees to use during 
your presentation. At any time during the meeting, you can change these settings.  

To Set Meeting Options 

1. Click Edit on the menu bar and click Meeting Options 

 

 

 

 

 

 

2. The Meetings Options dialog box will open (See 
below).  

3. To select an option, click the check box next to an 
option. To remove a selected option, clear the check 
box. 

 

 

Here’s a closer look at each option. 

Print to PDF allows attendees to convert the slides in the current 
presentation to a PDF file to save, print, or review 

Review slides allow attendees to review the slides at their own pace, 
independently of your control, by clicking View Slides on the View 
menu. 

Ask questions allows attendees to use the Questions and Answers 
panel to send text questions to you during your presentation 

Annotate/edit slides allows attendees to use the slide Annotation tools, 
such as the highlighter and stamps, to mark up your presentation. The 
Annotation tools appear at the top right of the slide display area 

The Interact options enhance the interaction between attendees and 
you. The See Who is in Attendance option lets your audience see and use the Attendees panel. 
The View Seating Chart option shows the Seating Chart panel and lets attendees send you 
feedback. The Chat option lets attendees chat with each other. To enable chat, you must select 
both the Attendees panel and the See Who is in Attendance options 

The Use slide set tools options allow attendees to work with slides in the presentation. You 
can allow them to select and show slides from the loaded presentation, insert new slides, or 
import a presentation to the meeting.  

Note:  
If you clear an option, it does not appear in the attendee’s meeting console 



 
MAINTENANCE WINDOW 
Microsoft performs regularly scheduled weekly maintenance on the Services.  Currently, 
scheduled maintenance is conducted every Friday from 6:00 p.m.–12:00 a.m. Saturday (Pacific 
Time) excluding nationally-recognized holidays in the United States.  During that time, the 
Services are not available.  Planned maintenance may be conducted by Microsoft or Global 
Crossing at other times as well.  Global Crossing will use commercially reasonable efforts to 
inform customers if planned maintenance will be performed at other times. 

SYSTEM REQUIREMENTS 

Please check the following system requirements to ensure your setup is able to run Live Meeting 
Conference Center.  
Windows meeting client 
·  Microsoft® Windows® 98, NT4 SP6a, 

2000 SP3, XP SP1  
o 166 MHz Pentium-based PC  

·  Microsoft® Internet Explorer 5.01 and 
higher, or Netscape® 7.x  

·  Microsoft® PowerPoint® 97, 2000, 
2002, 2003 (for presenters)  

Browser meeting client 
·  PC users  

o Microsoft Windows 98, NT4 SP6a, 
2000 SP3, XP SP1  

o Microsoft Internet Explorer 5.01 and 
higher, or Netscape 7.x  

o Sun JVM 1.4 or JVMs preinstalled 
with the supported browsers  

o Microsoft PowerPoint 97, 2000, 2002, 
2003 (for presenters)  

·  Mac users  
o Mac OS X 10.2  
o Internet Explorer 5.x (non-SSL) or 

Safari 1.0 (SSL if connecting without 
a proxy)  

·  Solaris users  
o Sun SPARCstation w/ Solaris 2.8, 

Solaris 2.9  
o Netscape 7.x  

Memory, bandwidth, and display 
requirements 
·  64 MB RAM  
·  56Kb/sec  
·  800x600 pixels required (1024x768 

recommended)  
Recording playback 
·  Live Meeting Replay format  

o Windows Media Player 6.4, 7.0, 7.1, 
9  

o 100Kb/sec  
o Not supported on Mac  

·  Basic Recording format  
o Windows Media Player 6.4 and 

higher, or Real Player G2 and 
higher  

o 100Kb/sec 
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